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Experiment 17:  Potentiometric Titration 
 

Objective:  In this experiment, you will use a pH meter to follow the course of acid-base 
titrations.  From the resulting titration curves, you will determine the concentrations of 
the acidic solutions as well as the acid-ionization constant of a weak acid. 

Introduction 

 You have performed acid-base titrations in the past to determine the concentration 
of an acidic or basic solution using a colored indicator.  However, there are times when 
an appropriate indicator does not exist, or where the color of the solution would obscure 
any color change associated with the endpoint.  In such cases, a pH meter can be used to 
monitor the acidity of the solution throughout the titration.  Recall the definition of pH: 

pH = –log[H3O+] 

The pH Meter (see Tro, p. 740) 

 A pH meter consists of two electrodes:  a glass electrode, which is sensitive to the 
concentration of hydronium ions in solution, and a reference electrode.  The reference 
electrode is often a calomel electrode, which supplies a constant potential (E° = +0.24 V 
versus the standard hydrogen electrode) as determined by the half-reaction 

Hg2Cl2  +  2 e–     2 Hg  +  2 Cl– 

Calomel is the trivial name for the compound Hg2Cl2.  When both the reference and glass 
electrodes are contained in a single unit, it is referred to as a combination electrode. 

 The potential of the glass electrode is proportional to the logarithm of the ratio of 
[H3O+] inside and outside the electrode.  The pH meter measures the total potential across 
the two electrodes and displays this measurement on a scale calibrated in pH units.  The 
pH meter is an accurate and easy-to-use device for determining the pH of a solution.  You 
will be using a pH electrode attached to the LabPro interface and computer as a pH meter 
in this experiment.  The appropriate set-up for a potentiometric titration is shown on 
Figure Page, Expt. 17, along with the details of glass and calomel electrodes. 

Potentiometric titrations 

 (See Tro, Chapters 15 and 16, especially pp 729-739.) 

 Figure 1 on the next page shows a plot of pH versus volume of base added for the 
titration of a strong acid with a strong base.  There is very little change in pH when the 
base is initially added.  Below the equivalence point, the pH is a function of the amount 
of excess acid present.  Above the equivalence point, the pH is a function of the amount 
of excess base present.  The equivalence point for the titration of a strong acid with a 
strong base occurs when [OH–] exactly equals [H3O+] in the solution; pH = 7.0. 

 The situation in the case of the titration of a weak acid with a strong base is 
somewhat different due to the fact that a weak acid is only partially ionized in aqueous 
solution.  A dynamic equilibrium exists, which is represented by the following equation: 

HA   +   H2O   H3O+   +   A– 
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Figure 1.  Titration curve for the titration of a strong acid with a strong base. 

The equilibrium expression for this reaction is: 

 Eq. 1 
 or 

where Ka is the acid-ionization constant for the weak acid.  Let us assume that the initial 
dissociation of the weak acid is negligible.  The progressive addition of NaOH during the 
titration decreases the concentration of HA and increases the concentration of its salt, 
NaA: 

HA (aq)  +  NaOH (aq)    H2O(l)  +  NaA (aq) 

The presence of both HA and its salt, NaA, creates a buffer system, which resists a large 
change in pH (see Tro, pp 714-728).  The ratio of [HA]/[A–] changes only slightly; 
therefore, according to Eq. 1, the change in [H3O+] (or pH) must also be small.  The pH 
increases slowly until the equivalence point is approached (see Figure 2 on the next 
page).  

 At the halfway point in the titration, exactly half of the HA originally present will 
have been neutralized, and therefore the concentrations of HA and A– will be equal.  
Substituting this information into Eq. 1, we obtain: 
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Figure 2.  Titration curve for the titration of a weak acid with a strong base. 
 
 

  Eq. 2 
Thus, the ionization constant of a weak acid is equal to the hydronium ion concentration 
at the halfway point in the titration; pKa = pH1/2.  This relationship is valid only if the 
initial dissociation of the acid is negligible.  When the degree of dissociation is 
appreciable, as in the case of a very dilute solution, the pH at the midpoint of the titration 
bears no relation to the value of Ka. 

 The subsequent rapid increase in pH and the inflection in the titration curve at the 
equivalence point can be accounted for.  As the equivalence point is approached, the 
concentration of unreacted HA becomes progressively smaller so that successive 
increments of NaOH neutralize a greater fraction of the HA remaining.  This produces a 
large change in the [HA]/[A–] ratio and, therefore, in the pH of the solution. 

 At the equivalence point, the acid and base have reacted completely to yield the 
salt, NaA.  The pH at the equivalence point is determined by the strength of the base, A–.  
The conjugate base of a weak acid is a strong base.  It will react with water to produce 
hydroxide ions (hydrolysis): 

A– (aq)   +   H2O (l)    HA (aq)   +   OH–  (aq)  

For this reason, it is not surprising to see a pH which is greater than 7 at the equivalence 
point. 

Ka =
[H3O+]1/ 2[A−]1/ 2

[HA]1/2

Ka = [H3O
+]1/ 2
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 Beyond the equivalence point, the pH is determined by the ion product for water: 

Kw = [H3O+][OH–] 

The first small excess of NaOH greatly increases the concentration of OH–, concomitantly 
decreasing the H3O+ concentration, and causing the pH to continue to increase.  Well past 
the equivalence point, the concentration of OH– becomes so large that only slight changes 
in pH are produced. 

 You will titrate a solution of HCl with a standardized solution of NaOH while 
measuring the pH throughout the course of the titration.  From your titration curve, you 
will determine the concentration of the HCl solution.   

 You will also titrate a sample of a commercial vinegar using a standard solution 
of NaOH.  The active ingredient in vinegar is acetic acid, which is a weak acid. 

CH3COOH (aq)   +   H2O (l)      CH3COO– (aq)   +   H3O+(aq)  

The acid-ionization constant of acetic acid is: 

From your titration curve, you will be able to determine the concentration of acetic acid 
in commercial vinegar. 

Ka =
[CH3COO−][H3O+]
[CH3COOH]

=1.74x10−5M
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Procedure (you do not need to outline instructions for using the LoggerPro software) 

Part I.  Calibrating the pH Electrode 

 You will use the computer to both acquire and analyze your data from this 
experiment.  Two students will work on the same computer and will obtain the same set 
of data.  A pH electrode should be plugged into Channel 1 of the interface box. 

 Click on the Applications folder at the bottom of the screen.  In the window that 
opens, click on the button labeled Logger Pro to open the Logger Pro software.   

Under the Experiment menu, choose Data Collection….  In the box that 
appears, click on the drop down menu next to Mode: and choose Events With Entry.  In 
this mode, the computer will record a pH measurement (a y value) every time you click 
on the mouse.  It will then allow you to type in a corresponding x value (volume) after it 
records the pH measurement.  The number of columns should be 1.  Next to Name: and 
Short Name:, type in Volume.  Next to Units:, type in mL.  Click on Done.  The empty 
graph will now appear with a pH label on the y-axis and a Volume (mL) label on the x-
axis. 

 To calibrate the pH electrode, you will need pH 4 and pH 7 buffer solutions.  
Remove the pH electrode from the bottle in which it is soaking by unscrewing the cap 
through which the electrode is inserted.  You do not need to pull the cap off.  Rinse off the 
pH electrode with a stream of water from a washbottle, shake off the drops and place it in 
the pH 7 buffer.  Swirl the bottle thoroughly.  Pull down the Experiment menu and 
choose Calibrate followed by LabPro: 1 CH1:pH.  In the box that appears, click on 
Calibrate Now.  Watch the channel input voltage reading.  When the number stops 
changing, highlight the box under Reading 1 and type 7.0.  Click on Keep.  Take the pH 
electrode out of the pH 7 buffer, rinse it off, place it in the pH 4 buffer and swirl the bottle.  
Wait until the channel input voltage reading is stable (it should be different from the 
previous voltage reading), then type in 4.0 under Reading 2, and click on Keep.  Click 
OK.  The pH electrode is now calibrated.  If you close this file or quit the program for any 
reason, the electrode must be re-calibrated. 

 Click once on the number at the very end of the x-axis.  Type in 30 and press 
return.  This will allow the computer to collect data until a total of 30 mL of titrant has 
been added (you can stop the data collection before 30 mL, if desired).  You are now 
ready to collect data.   

Part II.  Titration of a Strong Acid 

 Into a clean and dry 150 mL beaker, and with a carefully rinsed volumetric pipet, 
dispense a 10.00 mL aliquot of the 0.5 M HCl solution (do not pipet directly from the 
bottle).  Add exactly 75.0 mL of distilled water and 3 drops of phenolphthalein solution.  
Fill a clean and carefully rinsed buret with the standardized 0.5 M NaOH solution (record 
the exact molarity from the label).  Record the initial buret reading in your notebook.   
Remember throughout the experiment that you should record buret readings to the nearest 
one-hundredth of a milliliter. 

 Remove the pH electrode from the buffer solution.  Thoroughly rinse the 
electrode with distilled water, shake off the drops of water and place it in the acid 
solution such that the tip is immersed.  Stir the acid solution with the pH electrode (be 
careful not to break the glass tip!).  Now arrange the buret over the beaker so that the 
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NaOH can be dispensed directly into the acid solution (see Figure Page, Expt. 17).  The 
tip of the buret should be close enough to the surface of the solution such that no 
splashing occurs as the base is being added.   

 Click once on the green arrow button.  A circular button that is blue will appear 
next to the red rectangle.  Watch the pH reading that appears in the lower left corner of 
the screen (below the table).  When the pH is stable, click on the blue button.  At this 
point, a box appears into which you must enter a value for “Volume”, that is, the volume 
of NaOH which has been added as you proceed through the titration.  Since you have not 
added any NaOH at this point, type 0 (zero) and click OK or press return. 

 Begin the titration by adding, with stirring, 1 to 2 mL of NaOH.  Be careful not to 
splash any liquid out of the beaker.  When the pH reading is stable, stop stirring, then 
click on the blue button to record the pH of the solution.  Type in the total volume of 
NaOH that was added (the volume reading on the buret minus the initial volume reading 
that you recorded in your notebook) and hit return.  Continue to add base, record the pH 
by clicking the blue button and type in the total volume of NaOH added (the new 
reading on the buret minus the initial volume reading).  The pH values should increase in 
approximately 0.2 pH unit increments.  Be certain the solution is stirred after each 
addition of titrant and that the pH is stable before clicking the blue button.  Slow down 
even more as you approach the equivalence point!  As the pH readings approach 2, 
reduce the amount of base added to 0.1 mL increments.  Record in your notebook the pH 
reading when the pink phenolphthalein endpoint color persists for 30 seconds.  Add 
increments consisting of several drops of NaOH beyond this endpoint; then increase the 
increments of base to 1-2 mL until 10 mL more of NaOH has been added.  Click on the 
red button. 

 Important step:  Save your data!   
• Save your data by pulling down the File menu and selecting Save As... 
• In the dialog box that appears, the word Documents should be displayed in 

the drop down menu in the middle of the box.  If it is not, scroll through the 
menu on the left, and choose Documents. 

• Next to the words Save as:, type over the word “untitled” with the name of 
your file (example: HClNaOHlao).  You should include your initials in the 
name you choose. 

• Click on Save.   
• To find your file later, you will have to go to the Documents folder.  It should 

have the suffix .cmbl at the end of the file name. 

A note regarding “mistakes”:  If at any time during the above procedure you type an 
incorrect volume reading and hit return, simply make a note of the number of the 
“mistake” data point in your notebook, along with an explanation of the mistake, and 
continue with the titration.  You can delete unwanted data points or change the volume 
(x) value for a data point after you have stopped the data collection. 

 If you need to change a volume entry for any of the data points due to a mistake in 
entering the value, click in the appropriate cell of the Table Window and type in the 
correct value.  To delete a data point, click in the appropriate volume cell of the Table 
Window and press the delete key.  While the pH value for that data point cannot be 
deleted, the point will no longer appear on the graph once the volume value has been 
erased.   
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 You can adjust the axes on your graph using the AutoScale button in the toolbar 
or by clicking on the numbers at the ends of the axes and typing in the desired limits.  
You can adjust other graph parameters in the Graph Options… found under the Options 
menu.  Because the Logger Pro program does not draw the smoothest curve through data 
points but instead simply connects the dots, it is best to print this plot without Connecting 
the Points, but with Point Protectors.  Type an appropriate title for the graph in the box 
under Title.  Your initials should appear in parentheses at the end of the title (so you can 
identify your printout).  Click on OK.   

To print the graph, pull down the File menu and choose Printing Options….  
Click in the box next to Print Footer to make sure a check mark appears, then type in 
your name (and a comment about the plot, if desired).  Print both the plot and data table.  
Use the Print Graph and Print Data Table commands from the File menu. 

Part III.  Titration of vinegar 

 Pull down the Experiment menu and select Store Latest Run.  Under the Data 
menu, choose Hide Data Set followed by Run 1.  You can now collect a new data set.  
Click once on the number at the end of the x-axis, type in 30 and press return.  Click once 
on the number at the bottom of the y-axis, type 0 and return, then click on the upper limit, 
type 14 and return. 

 Refill the buret with the standardized 0.5 M NaOH solution provided.  Record the 
initial volume of NaOH in your notebook.  Using a carefully cleaned and rinsed transfer 
pipet, dispense a 10.00 mL aliquot of vinegar into a clean, dry 150 mL beaker (do not 
pipet directly from the bottle).  Dilute this aliquot with exactly 75.0 mL of distilled water.  
Add 3 drops of phenolphthalein solution. 

   Thoroughly rinse the electrode with distilled water, shake off the drops of water 
and place it in the vinegar solution.  Stir the vinegar with the pH electrode (be careful not 
to break the glass tip!), and arrange the buret above the beaker for a titration.  Click on 
the green  button.  Titrate the vinegar as you did the HCl solution above.  As you 
approach the equivalence point, decrease the size of the base increments until single 
drops are being added.  Record in your notebook the pH reading when the pink 
phenolphthalein endpoint color persists for 30 seconds.  Continue the titration until a pH 
of approximately 12 has been reached.  Click on the red button, then save your data. 

 Adjust the axes and type in a title for your graph.  Print out your plot (without 
Connecting the Points) and data table.   

 To directly compare the shapes of the two titration curves, choose Show Run 1 
from the Data menu, and the plot from your first titration will appear.  You can display 
one or both runs simply by using the Show Run and Hide Run options.  You may need 
to re-adjust axes limits.   

 All of the solutions in this experiment may be poured down the sink.  Clean off  
your lab bench before you leave and return the rinsed pH electrode to the plastic bottle.   
Do not lose the rubber o-ring! 

 Record the percent acidity of the vinegar from the label on the bottle. 

 When you are ready to leave, pull down the Logger Pro menu and choose Quit 
Logger Pro.   
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You should leave the laboratory with printouts of all the necessary plots that you 
produced today.  However, you should also store a copy of your data file(s) using either 
www.bc.edu/myfiles or by e-mailing the file(s) to yourself (see Storing and Retrieving 
Your Lab Files on page 14 of the notebook/manual).  If you need to adjust any of your 
plots after your lab period is over, you can use the computers in the chemistry teaching 
labs when the rooms are not occupied (MWF 9:00-12:45 or TuTh 12:00-1:15). 

 

Each student must write his/her own Calculations and answers to the Questions for 
this experiment.  Do not hand in one report per pair.  Do not hand in identical 
reports.
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Calculations 

1. a)  On the plot resulting from the titration of HCl with NaOH, draw the best curve 
through the data points by hand.  Locate the equivalence point and determine 
the pH and volume at this point.  Label the point where the phenolphthalein 
endpoint became visible.   

b)  Using the molarity and volume of base solution required to reach the 
equivalence point, calculate the concentration of the HCl solution which was in 
the bottle in molarity. 

2. a)  On the plot resulting from the titration of vinegar with NaOH, draw the best 
curve through the data points by hand.  Locate the equivalence point and note 
the pH and volume at this point.  Label the point where the phenolphthalein 
endpoint became visible.     

b)  Using the molarity and volume of base solution required to reach the 
equivalence point, calculate the concentration of acetic acid in the vinegar 
bottle in molarity. 

3. The label on the vinegar states its percent acidity.  This quantity corresponds to 
the mass percent of acetic acid in vinegar (g acetic acid/100 g vinegar).  
Convert the molar concentration of acetic acid that you obtained to mass 
percent (note: density of vinegar is 1.008 g/mL).  Compare this value to the one 
reported on the label and calculate the percent error (see Expt. 8). 

4.   To find the pH at the halfway point of the curve, divide the volume of base 
needed to reach the equivalence point by 2, and read off the corresponding pH 
from the titration curve.  Determine the value of Ka for acetic acid. 

5.   Using the concentration of acetic acid that you calculated in question 2.b) 
above along with the literature value for Ka given in the introduction  
(1.74 x 10–5 M), calculate the initial pH of the vinegar sample (after diluting it 
with 75.0 mL of water but before any base has been added).  [Hint:  Refer to  
p. 734 in Tro.] 

6. Using your calculated concentration of acetic acid and the literature value for 
Ka, calculate the pH of the vinegar sample at the equivalence point.  For the 
volume of base added at the equivalence point, use the amount determined 
from your titration curve.  Refer to pp 735-736 in Tro. 

7.   Using your calculated concentration of acetic acid, calculate the pH of the 
vinegar sample after 25.00 mL of standardized NaOH solution has been added 
(when the solution is well past the equivalence point).  At this point in the 
titration, you may assume that the pH of the solution depends upon the 
concentration of OH– ions.  See p. 737 in Tro. 

Questions 

1.  Compare the equivalence point of the first titration (hydrochloric acid) with 
the endpoint determined by phenolphthalein indicator.  If you had determined 
the equivalence point by the color change of the phenolphthalein, would the 
value calculated for the concentration of the HCl solution have been larger, 
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smaller or the same as the value you determined by potentiometric titration?  
Explain. 

2. List the advantages and disadvantages associated with doing a titration using a 
pH electrode interfaced to a computer as opposed to doing a titration using an 
indicator. 

3.  Discuss possible error sources and how they might affect your results. 

 


